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Basic Operations in the Menu display

Pressing the [MENU] button calls up the Menu display. The Menu display contains five menus and allows you to make settings 
related to Voice, Song, Metronome/Rhythm, Recording and System (overall settings for the instrument). This section explains the 
basic operations in the Menu display.
For the following, you will need to make additional settings before opening the Menu display.

• When you want to edit Voice-related parameters:
Select a Voice. If you want to edit Voices in Dual/Split/Duo, turn on the desired function.

• When you want to edit Song-related parameters:
Select a Song.

1. Press the [MENU] button several times to select the desired menu.
Pressing the button repeatedly switches among the menus. The menu name shown at the top of the display and the icon at 
left indicate the selected menu.

2. Use the [u]/[d]/[l]/[r] buttons to select the desired parameter.

3. Use the [l]/[r] buttons to change the setting or execute the operation.
To reset the selected item to the default value on the CLP-885, CLP-875 and CLP-895GP, press and hold the [MENU] button 
until the value is reset. On the CLP-845, CLP-835 and CLP-865GP, press the [<] and [>] buttons simultaneously. 

4. To exit from the Menu display, press the [EXIT] button.

Voice menu page 3
For making keyboard performance settings (pedal function, volume balance in 
Dual/Split/Duo, transpose, etc.), and for editing Voices.

Song menu page 9
For making Song playback settings (repeat playback, volume, transpose, etc.), for 
editing Songs, and for handling Song files.

Metronome/
Rhythm menu

page 16
For adjusting the metronome and rhythm volume, setting the metronome time 
signature, and making rhythm related settings.

Recording menu page 18 For making MIDI recording settings.

System menu page 20
For making settings for the entire instrument (tuning, sound, Audio Power Off, 
display brightness, etc.), formatting a USB flash drive, and backing up the 
instrument settings.

885 875 895GP 845 835 865GP

41
2, 3

2, 3
4

1

Menu name
Menu name

Menu icons
Menu icons
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Voice menu

The Voice menu lets you edit or set various parameters related to keyboard performance, such as Voice parameters. While 
playing the keyboard and listening to the sound, change the parameter values one-by-one to arrive at your desired sound. When 
you make settings of Voices in Dual, Split or Duo, make sure to turn on Dual, Split or Duo before calling up the Voice menu.

Operation:
Press the [MENU] button several times to select Voice menu, and then use the [u]/[d]/[l]/[r] buttons to select the 
desired parameter and change the settings.

Parameter Description Setting range Default setting

Transpose Shifts the pitch of the entire keyboard up or down in 
semitone intervals to facilitate playing in difficult key 
signatures, and to let you easily match the pitch of the 
keyboard to the range of a singer or other instruments. 
For example, if you set this parameter to “5,” playing 
key C produces pitch F. In this way, you can play the F 
major song as if it were in C major.

NOTE
• The setting here will not affect Song playback. If you want to 

transpose Song playback, use the “Transpose” parameter in the 
Song menu (page 10).

• With Audio recording, the transposed sound is recorded according to 
the setting here. With MIDI recording, the “Transpose” value in the 
Song menu (page 10) is offset from the setting here.

• Your keyboard performance data will be transmitted with the 
transposed note numbers while MIDI note numbers received from an 
external MIDI device or computer will not be affected by the 
Transpose setting.

−12 (−1 octave) 
– 0 (normal 
pitch) – +12 (+1 
octave)

0

Piano 
Setting
* These settings 

are effective only 
for the piano 
Voices having 
VRM effects.

Lid Position Recreates the differences in sound depending on how 
high the (virtual) grand piano lid is opened.

Full, Half, Close Full

VRM Turns the VRM effect on/off.

 VRM (Virtual Resonance Modeling)
The VRM (Virtual Resonance Modeling) function uses 
sophisticated physical modeling to simulate the actual string 
resonance sound that occurs when the damper pedal on a 
real piano is pressed or keys are played and held. On an 
actual acoustic piano, if you press the damper pedal and play 
a key, not only does the string of the pressed key vibrate, it 
also causes other strings and the soundboard to vibrate, each 
influencing the rest and creating a rich and brilliant resonance 
that sustains and spreads. The VRM technology featured in 
this instrument reproduces the complicated interaction of both 
string and soundboard resonance faithfully using a virtual 
musical instrument (physical modeling), and makes the sound 
more like a real acoustic piano. Since instantaneous 
resonance is made at the moment according to the state of 
the keyboard or pedal, you can vary the sound expressively 
by changing the timing of your pressing the keys, and the 
timing and depth of your pressing the pedal.

When “VRM” is On, set the following parameters as 
desired.

On, Off On

Damper Res.
(Resonance)

Determines the depth of the string 
resonance effect which is applied 
when the damper pedal (right pedal) 
is pressed.

0 – 10 5



Voice menu

CLP-885 CLP-875 CLP-845 CLP-835 CLP-895GP CLP-865GP  Reference Manual 4

Piano 
Setting
* These settings 

are effective only 
for the piano 
Voices having 
VRM effects.

VRM Damper 
Noise

Turns the Damper Noise On/Off. This 
function will be disabled when 
“Damper Res.” is set to 0.

 Damper Noise
Damper noise is the sound made on an 
acoustic piano when the damper pedal is 
pressed. The damper noise changes in 
tone and volume depending on how 
quickly the damper pedal is pressed 
down. Pressing the damper pedal slowly 
will make a quieter sound when the 
damper heads are released from the 
strings. Pressing the damper pedal with 
force will transmit the vibrations to the 
strings, which adds a lower and louder 
sound.

On, Off On

String Res.
(Resonance)

Determines the depth of the string 
resonance effect which is applied 
when a note on the keyboard is 
pressed.

0 – 10 5

Duplex 
Scale Res.
(Resonance)

Adjusts the sympathetic vibrations of 
the duplex scaling resonance effect.

 Duplex Scale
Duplex scaling is a stringing method for 
pianos that uses extra, un-struck strings 
in the upper octaves to enhance the tone. 
These strings sympathetically vibrate 
with other strings in an acoustic piano, 
resonating with overtones, and adding 
richness, brilliance and complex color to 
the sound. Since the dampers do not 
touch them, they will continue sounding 
even after you release your hands from 
the keyboard.

0 – 10 5

Body Res.
(Resonance)

Adjusts the resonance of the piano 
itself (the soundboard, the sides, the 
frame and so on).

0 – 10 5

Grand Exp.
(Expression)

Selects the type of the Grand Expression Modeling 
effects, which simulates the physical sound transitions 
of an actual piano. When this feature is set to 
“Dynamic,” you can control extremely subtle nuances in 
the performance and sound by changing your playing 
strength, touch or how you release the keys. When set 
to “Static,” the nuances are generally fixed.

 Grand Expression Modeling
On an actual acoustic piano, subtle changes in the sound can 
be produced by changing your playing touch from when you 
press a key to when you release it. For example, when you 
press a key all the way to its bottom, the key hits the keybed 
underneath an the noise reaches the strings, changing the 
sound slightly. Furthermore, the tone when the damper is 
lowered onto strings to mute the sound is changed by how 
quickly you release the key. Grand Expression Modeling 
technology recreates these subtle changes in the sound that 
respond to your touch. This allows you to add accents by 
playing strongly or add resonance by playing softly to produce 
superbly expressive sound. A crisp tone can be heard when 
playing staccato as well as a lingering sound produced when 
releasing the keys slowly.

Dynamic, Static Dynamic

Operation:
Press the [MENU] button several times to select Voice menu, and then use the [u]/[d]/[l]/[r] buttons to select the 
desired parameter and change the settings.

Parameter Description Setting range Default setting



Voice menu

CLP-885 CLP-875 CLP-845 CLP-835 CLP-895GP CLP-865GP  Reference Manual 5

Reverb Determines the Reverb type which is applied to all the 
entire sound including the keyboard performance, 
Song playback and MIDI data input from an external 
MIDI device.

• Off: No effect.

• Recital Hall: Simulates clear reverberation in a mid-sized 
hall suitable for piano recital.

• Concert Hall: Simulates brilliant reverberation in a large 
hall for public orchestra performances.

• Chamber: Simulates the elegant reverberation in a small 
room suitable for chamber music.

• Room: Simulates the soft reverberation of a smaller 
performance space, such as a room or lounge.

• Cathedral: Simulates the solemn reverberation in a high-
ceiling stone-made cathedral.

• Club: Simulates the lively reverberation in a jazz club or a 
small bar.

• Plate: Simulates the bright sound of vintage reverb 
equipment used in recording studios.

(See the column 
at left.)

(Differs 
depending on 
the Voice or 
Voice 
combination.)

Chorus Determines the Chorus type which is applied to all the 
entire sound including the keyboard performance, 
Song playback and MIDI data input from an external 
MIDI device.

• Off: No effect.

• Chorus: Adds a rich, spacious sound.

• Celeste: Adds swell and a spacious sound.

• Flanger: Adds swell effects similar to the sound of an 
ascending or descending jet plane.

(See the column 
at left.)

(Differs 
depending on 
the Voice or 
Voice 
combination.)

Voice Edit By changing the settings below, you can edit the sound of the selected Voice as desired. 
When Dual, Split or Duo is turned on, multiple Voice names are shown in the “Voice Edit” display. Select the 
target Voice, and then edit it. 

• When Dual is on: upper column = Voice 1, lower column = Voice 2
• When Split is on: upper column = Right Voice, lower column = Left Voice
• When Dual and Split are on: upper column = Right 1 Voice, middle column = Right 2 Voice, lower column = 

Left Voice
• When Duo is on: upper column = Voice for the Right player, lower column = Voice for the left player

Octave Shifts the pitch of the keyboard up and down in octave 
steps.

−2 – 0 (no pitch 
shift) – +2

(Differs 
depending on 
the Voice or 
Voice 
combination.)

Volume Adjusts the volume for the selected Voice. 0 – 127

Reverb 
Depth

Adjusts the depth of the selected Reverb type. 
A setting of 0 produces no effect.

NOTE
When a VRM Voice is used for several parts simultaneously, 
unexpected sounds may occur. This is because the Reverb depth for a 
part which has priority will be applied to all parts. During Song 
playback, setting for a Song part is used (priority order: Ch. 1, 
Ch. 2...Ch. 16), while the setting for a keyboard part is used when 
Song playback is stopped (priority order: R1, L and R2 Voices).

0 – 127

Operation:
Press the [MENU] button several times to select Voice menu, and then use the [u]/[d]/[l]/[r] buttons to select the 
desired parameter and change the settings.

Parameter Description Setting range Default setting
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Voice Edit Chorus 
Depth

Adjusts the depth of the selected Chorus type. 
A setting of 0 produces no effect.

NOTE
When a VRM Voice is used for several parts simultaneously, 
unexpected sounds may occur. This is because the Reverb depth for a 
part which has priority will be applied to all parts. During Song 
playback, setting for a Song part is used (priority order: Ch. 1, 
Ch. 2...Ch. 16), while the setting for a keyboard part is used when 
Song playback is stopped (priority order: R1, L and R2 Voices).

0 – 127 (Differs 
depending on 
the Voice or 
Voice 
combination.)

Effect Determines the Effect type. Reverb and Chorus are 
applied to all the entire sound while the Effect selected 
here is applied only to the selected Voice. Effects 
cannot be applied to the VRM Voices.

• Off: No effect.

• DelayLCR: Delay applied at left, center, and right positions.

• DelayLR: Delay applied at left and right positions.

• Echo: Echo-like delay.

• CrossDelay: Left and right delays cross each other in 
alternation.

• Symphonic: Adds a rich and deep acoustic effect.

• Rotary: Adds the vibrato effect of a rotary speaker.

• Tremolo: The volume level changes in rapid cycles.

• VibeRotor: The vibrato effect of a vibraphone.

• AutoPan: The sound pans left to right and back and forth.

• Phaser: The phase changes periodically, swelling the 
sound.

• AutoWah: The center frequency of the wah filter changes 
periodically.

• Distortion: Distorts the sound.

(See the column 
at left.)

Rotary 
Speed

Available only when “Rotary” is selected as an Effect 
type. This parameter determines the rotation speed of 
the Rotary Speaker effect.

Fast, Slow

VibeRotor Available only when “VibeRotor” is selected as an 
Effect type. This parameter turns on or off the 
VibeRotor effect.

On, Off

VibeRotor 
Speed

Available only when “VibeRotor” is selected as an 
Effect type. This parameter determines the speed of 
the Vibraphone vibrato effect.

1 – 10

Effect Depth Adjusts the Effect depth for the selected Voice. Certain 
Effect types do not allow adjustment of depth.

1 – 127

Pan Adjusts the stereo pan position for the selected Voice. L64 (leftmost) – 
C (center) – R63 
(rightmost)

Harmonic 
Cont
(Content)

Produces a distinctive “peaky” tone by raising the 
Resonance value of the filter.

NOTE
Harmonic content may have little audible effect or not be applied to 
some Voices.

−64 – +63

Brightness Adjusts the brightness of the selected Voice. −64 – +63

Operation:
Press the [MENU] button several times to select Voice menu, and then use the [u]/[d]/[l]/[r] buttons to select the 
desired parameter and change the settings.

Parameter Description Setting range Default setting
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Pedal Function List

This is a list of the functions that can be assigned to each of the left, center and right pedal from “Pedal Assign” in the Voice menu. 
The assignable functions differ depending on the pedal.

Voice Edit Touch Sens.
(Sensitivity)

Determines the degree to which the volume level 
changes in response to your touch on the keyboard 
(how hard you play). Since the volume level of some 
Voices such as Harpsichord and Organ do not change 
regardless of how you play the keyboard, the default 
setting for these Voices is 127.

0 (softest) – 64 
(largest changes 
in the level) – 
127 (loudest 
regardless of 
how you play the 
keyboard)

(Differs 
depending on 
the Voice or 
Voice 
combination.)

RPedal Turns the function of the right, center or left pedal on/
off for the selected Voice. This parameter is useful 
when you want to ensure, for example, that the pedal 
function affects the right-hand performance but does 
not affect the left-hand performance when Split is on. 

On, Off

CPedal

LPedal

Pedal 
Assign

Right Changes the functions of the right, center, or left pedal.

NOTE
The default setting of the left pedal differs for certain Voices: “Rotary 
Speed” for the “Jazz Organ 1,” “Jazz Organ 2” or “Rock Organ” Voice, 
and “VibeRotor” for the “Vibraphone” Voice.

(Refer to the 
Pedal Function 
List below.)

Sustain (Cont.)

Center Sostenuto

Left Soft

Balance
* Only the available 

parameters are 
shown when 
Dual, Split or Duo 
is on.

Volume 
R2 – R1

Adjusts the volume balance between two Voices when 
Dual is on. Moving the slider rightward raises the 
Right 1 volume and lowers the Right 2 volume, and 
vice versa.

R2+10 – 0 – 
R1+10

(Differs 
depending on 
the Voice or 
Voice 
combination.)

Volume 
L – R

Adjusts the volume balance between the right and left 
sections when Split or Duo is on. Moving the slider 
rightward raises the right section volume and lowers 
the left section volume, and vice versa.

L+10 – 0 – R+10

Detune Detunes the Right 1 Voice and Right 2 Voice in Dual to 
create a thicker sound. Moving the slider rightward 
raises the Right 1 Voice pitch and lowers the Right 2 
Voice pitch, and vice versa.

R2+20 – 0 – 
R1+20

Function Description Assignable or not (: Yes, –: No)

Left 
pedal

Center 
pedal

Right 
pedal

Sustain (Switch) Sustains the notes you play while pressing the pedal, even 
after releasing your fingers from the keyboard.

  

Sustain (Cont.) Sustains the notes you play while pressing the pedal, even 
after releasing your fingers from the keyboard. The sustain 
length varies depending on how far the pedal is pressed.

– – 

Sostenuto If you play a note or chord on the keyboard and press the pedal 
while holding the note(s), the notes will sustain as long as the 
pedal is held. All subsequent notes will not sustain. 

  

Soft Reduces the volume and slightly changes the timbre of notes 
played while the pedal is pressed.

  

PitchBend Up Raises the pitch smoothly. – – 

PitchBend Down Lowers the pitch smoothly. – – 

Operation:
Press the [MENU] button several times to select Voice menu, and then use the [u]/[d]/[l]/[r] buttons to select the 
desired parameter and change the settings.

Parameter Description Setting range Default setting
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NOTE
• For certain Voices, such as strings and organ, the sound may sustain continuously when the pedal (to which the damper/sostenuto function assigned) is pressed.
• If the [PLAY/PAUSE] function is assigned to a pedal from “Pedal” > “Play/Pause” in the System menu (page 22), the corresponding pedal's function assigned here is 

disabled.

Rotary Speed Switches the Rotary Speaker speed (for the Jazz Organ 1, 2 or 
Rock Organ Voices) between “Fast” and “Slow” each time you 
press the pedal.

  

VibeRotor Switches the vibrato on/off (for the Vibraphone Voice) each 
time you press the pedal.

  

Function Description Assignable or not (: Yes, –: No)

Left 
pedal

Center 
pedal

Right 
pedal
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Song menu

The Song menu lets you set various parameters related to Song playback and edit the Song data. Select a desired Song before 
beginning the operation.
Available parameters differ between MIDI Songs and Audio Songs. The following parameters indicated with “(Audio)” can be set 
only when an Audio Song is selected, and parameters with “(MIDI)” can be set only when a MIDI Song is selected. “Edit” 
parameters cannot be set for the preset Songs and Voice Demo Songs.

NOTICE
”Execute” is a function that edits or changes the current Song data. Note that pressing the [r] button replaces the original data with new data. 

Operation:
Press the [MENU] button several times to select Voice menu, and then use the [u]/[d]/[l]/[r] buttons to select the 
desired parameter and change the settings.

Parameter Description Setting range Default setting

Volume
(Audio)

Adjusts the volume of the selected Audio Song. 0 – 127 100

Repeat
(Audio)

Selects the repeat type for Song playback.

• Off: Disables repeated playback. When playback of the 
selected Song reaches the end, playback stops 
automatically.

• Single: Plays through only the selected Song repeatedly.

• All: Continuously plays back all Songs in the folder which 
contains the selected Song in numerical order.

• Random: Continuously plays back all Songs in the folder 
which contains the selected Song in random order.

When a repeat type other than Off is selected, the 
status icon (Single: , All: , Random: ) is 
shown on the upper right of the Song display.

Off, Single, All, 
Random

Off

L / R
(MIDI)

R Turns each part of the selected MIDI Song on (play) or 
off (mute). For parts having no data, “---” is shown the 
part cannot be turned on or off.

NOTE
A MIDI Song consists of 16 tracks (parts), and usually track 1 is 
assigned to “R,” track 2 is assigned to “L,” and tracks 3−16 are 
assigned to “Extra.”

On, Off On

L

Extra

Repeat
(MIDI)

A – B Lets you play back a specified range (from Point A to 
B) of the selected MIDI Song repeatedly.
1. Press the [PLAY/PAUSE] button to start playback of 

the Song.
2. Press the [r] button at the starting point (A) of the 

range to be repeated.
3. Press the [r] button again at the ending point (B). 

After an automatic lead-in (to help guide you into 
the phrase), the range from Point A to Point B is 
played back repeatedly

To disable A-B Repeat, press the [r] button in the A-B 
Repeat display while “Repeat Off” is selected. 
Selecting another Song also disables A-B Repeat.

NOTE
• To specify the top of the Song as the starting point (A), specify Point 

A before starting playback.
• To specify the end of the Song as the ending point (B), play back 

through until the end of the Song. The point B is automatically set 
without you needing to press any button.

On, Off Off
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Repeat
(MIDI)

Phrase This parameter can be set when a MIDI Song 
containing the Phrase Mark settings is selected. You 
can play back a specified phrase in the Song 
repeatedly. To do this, specify a phrase number in 
“Phrase Mark” and set “Repeat” to “On,” and then start 
Song playback. 
If you play back the Song while “Repeat” is “Off,” the 
Phrase Mark number on this display advances 
allowing you to check the phrase number of the 
currently played phrase while listening to it.
When “Repeat” is “On,” the Phrase Mark Repeat icon 
( ) is shown on the upper right of the Song 
display.

On, Off Off

Song Selects the repeat type for Song playback.

• Off: Disables repeated playback. When playback of the 
selected Song reaches the end, playback stops 
automatically.

• Single: Plays through only the selected Song repeatedly.

• All: Continuously plays back all Songs in the folder which 
contains the selected Song in numerical order.

• Random: Continuously plays back all Songs in the folder 
which contains the selected Song in random order.

When a repeat type other than Off is selected, the 
status icon (Single: , All: , Random: ) is 
shown on the upper right of the Song display.

Off, Single, All, 
Random

Off

Volume
(MIDI)

Song – 
Keyboard

Adjusts the volume balance between the MIDI Song 
playback sound and keyboard performance.

Song+64 – 0 – 
Key+64

0

Song L – R Adjusts the volume balance between the right-hand 
and left-hand parts of MIDI Song playback.

L+64 – 0 – R+64 0

Transpose Shifts the pitch of Song playback up or down in 
semitone intervals. For example, if you set this 
parameter to “5,” a Song created in C major will be 
played back in F major. This setting does not affect the 
keyboard pitch.

NOTE
• Applying transpose to an Audio Song may change its tonal 

characteristics.
• The audio signal input from the external devices is not transposed.
• MIDI Song playback data will be transmitted with the transposed note 

numbers while MIDI note numbers received from an external MIDI 
device or computer will not be affected by the Transpose setting.

−12 (−1 octave) 
– 0 (normal 
pitch) – +12 
(+1 octave)

0

File Delete These are file operations, such as deleting, copying, 
moving the Songs saved to the instrument or the 
connected USB flash drive. For details, refer to 
“Managing the Song files” (page 12).

– –

Copy
(MIDI)

Move
(MIDI)

MIDI to Audio
(MIDI)

Rename

Delete All

Operation:
Press the [MENU] button several times to select Voice menu, and then use the [u]/[d]/[l]/[r] buttons to select the 
desired parameter and change the settings.

Parameter Description Setting range Default setting
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Edit
(MIDI)

Quantize Aligns the timing of each note in the selected MIDI 
Song. For example, if you record a musical phrase in 
4/4 time, you may not play it with absolute precision, 
and parts of your performance may have been slightly 
ahead of or behind the precise timing. Quantize is a 
convenient way of correcting for this. For details, refer 
to “Quantize (aligning the timing of notes)” (page 13).

– –

Track Delete Deletes data of a specific track from the selected MIDI 
Song. For details, refer to “Track Delete (deleting data 
of a specific track)” (page 14).

– –

Tempo 
Change

Changes the tempo of the selected MIDI Song to the 
current tempo and overwrites the data. For details, 
refer to “Tempo Change (changing the tempo value)” 
(page 15).

– –

Voice 
Change

Changes the Voice of a specific track in the selected 
MIDI Song to the current Voice and overwrites the 
data. For details, refer to “Voice Change (changing the 
Voice of a specific track)” (page 15).

– –

Others
(MIDI)

Quick Play This lets you specify whether a Song that starts from 
the middle of a bar, or a Song with a silence prior to the 
first note, should be played from the first note or from 
the top of the bar (rest or blank). This is useful for a 
MIDI Song that starts with a short one-or two-beat 
pick-up or lead-in.

On, Off On

Track Listen This lets you play back only one track of the selected 
MIDI Song to listen to its contents. To do this, select a 
track, move the highlight to “Start,” and then press and 
hold the [r] button to start playback from the first note. 
Playback continues while holding the [r] button.

Track 1 – 
Track 16

Track 1

Play Track This lets you specify the tracks of the selected MIDI 
Song for playing back on this instrument. When “1&2” 
is selected, only tracks 1 and 2 are played back, while 
tracks 3 to 16 are transmitted to the connected device 
via MIDI. When “All” is selected, all tracks are played 
back on this instrument.

All, 1&2 All

Operation:
Press the [MENU] button several times to select Voice menu, and then use the [u]/[d]/[l]/[r] buttons to select the 
desired parameter and change the settings.

Parameter Description Setting range Default setting
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Managing the Song files

The “File” parameters in the Song menu lets you delete an unnecessary Song, copy the recorded Song on the instrument to the 
USB flash drive, or make other Song file-related operations to manage the Song files in the “User” or “USB” category.

Song types and file operation limitations
The following chart shows the Song type and restrictions on File operations. Song types are indicated as the category name and 
icon in the Song display. 

 : Available, –: Not available

1. As necessary, connect a USB flash drive to the USB [TO DEVICE] terminal.

2. Select a Song for handling.

3. Select the desired operation from “File” in the Song menu.

Operation Description Song type

Category User USB

Icon

(MIDI) (MIDI) (Audio)

Delete Deletes the selected Song.   

Copy Copies or moves the selected MIDI Song to “User” or “USB.”
As for a MIDI Song in the “User” category in the instrument, you can 
copy or move it only to the “USER FILES” folder on a USB flash drive. 
As for a MIDI Song in a USB flash drive, you can Copy/Move it to the 
“User” category in the instrument. 

  –

Move   –

MIDI to Audio Converts the selected MIDI Song to an Audio Song during playback.
This is basically the same as that of Audio Recording, which allows you
to record your keyboard performance and other audio input sound via
Bluetooth or [AUX IN] jack, etc.

  –

Rename Changes the name of the selected Song.   

Delete All Deletes all Songs in the folder which contains the selected Song.
When a Song in the “User” category is selected, all Songs in the “User” 
are deleted. When a Song in the “USB” category is selected, all Songs 
in the “USER FILES” folder of the connected USB flash drive are 
deleted.

NOTE
The Songs in the folder contained in the “USER FILES” folder of the USB flash drive are not 
deleted.

  

Song nameIcon

Category name

Instrument

USB flash drive

User

Can be copied/moved.

Can be copied/moved.

Root

USER FILES 
folder
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4. Execute the selected operation.

• When “Delete,” “Copy,” “Move,” “MIDI to Audio” or “Delete All” is selected:

4-1. Press the [r] button to call up the operation display.

4-2.  Press the [d] button to select “Execute,” and then press the [r] button to execute the operation.

NOTICE
• Do not turn off the power or disconnect the USB flash drive while executing. Doing so may result in the loss of all data.
• A message appears when a Song with the same name already exists in the copy/move destination. If you select “Overwrite,” the 

previously existing original data of the Song will be lost.

• When “Rename” is selected:

4-1. Press the [r] button to call up the operation display.

4-2. Change the name of the Song.
Use the [l]/[r] buttons to move the cursor (underline), and then use the [u]/[d] buttons to change the character at 
the current cursor position. To delete the character at the current cursor position, press the [REC] button.
A Song name can contain up to 46 characters. Characters which extend beyond the display capacity and are not visible 
can be viewed by moving the cursor by using the [l]/[r] buttons.

NOTE
For information about the character types available for the Song name, refer to “Utility” > “Language” on page 26 in the System menu.

4-3. Press the [MENU] button to actually rename the Song.

NOTICE
Do not turn off the power or disconnect the USB flash drive while executing. Doing so may result in the loss of all data.

Editing the selected MIDI Song

From “Edit” in the Song menu, you can change the data of the selected MIDI Song in the “User” or “USB” category and overwrite 
it.

Quantize (aligning the timing of notes)
This function allows you to align the timing of each note in the selected MIDI Song. For example, if you record the musical phrase 
shown below, you may not play it with absolute precision, and your performance may have been slightly ahead of or behind the 
precise timing. Quantize is a convenient way of correcting for this.

1. Select the desired MIDI Song to edit.

2. Select “Edit” > “Quantize” in the Song menu.

3. Set “Quantize” value to the smallest notes in the MIDI Song.

Cursor
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• Settings: • Example of 1/8 note quantization:

The three Quantize settings marked with asterisks (*) are exceptionally convenient, since they allow you to quantize two different note values at the same time. 
For example, when the straight eighth notes and eighth notes triplet are contained in the same part, if you quantize by straight eighth notes, all notes in the part 
are quantized to straight eighth notes—completely eliminating any triplet feel. However, if you use the eighth note + eighth note triplet setting, both the straight 
and triplet notes will be quantized correctly.

4. Set the “Strength” value, which determines how strongly the notes will be quantized.
A setting of 100% produces exact timing. If a value less than 100% is selected, notes will be moved toward the specified 
quantization beats according to the specified percentage. Applying less than 100% quantization lets you preserve some of 
the “human” feel in the recording.

5. Select “Execute” and press the [r] button to save the edited data.
NOTICE
Pressing the [r] button overwrites the data of the selected MIDI Song. Be careful not to lose your important data.

Track Delete (deleting data of a specific track)
This function lets you delete data of a specific track from the selected MIDI Song.

1. Select the desired MIDI Song to edit.

2. Select “Edit” > “Track Delete” in the Song menu.

3. Select the desired track to delete in “Track.”

In the track selection display, the “*” mark indicates the track which contains the data. To check the recorded data, play it 
back from “Others” > “Track Listen” in the Song menu (page 11).

1/4................

1/8................

1/16.............

1/6................

1/12.............

1/24.............

1/8+1/12.........

1/16+1/24.......

1/32.............

1/16+1/12.......

quarter note

quarter note triplet

eighth note

eighth note triplet

sixteenth note

sixteenth note triplet

thirty-second note

eighth note + eighth note triplet*

sixteenth note + eighth note triplet*

sixteenth note + sixteenth note triplet*

Original data

Quantizing strength = 100%

Quantizing strength = 50%

Quarter-note length
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4. Select “Execute” and press the [r] button to save the edited data.
NOTICE
Pressing the [r] button overwrites the data of the selected MIDI Song. Be careful not to lose your important data.

Tempo Change (changing the tempo value)
This function lets you change the tempo value of the selected MIDI Song and overwrite the data.

1. Select the desired MIDI Song to edit.

2. Press the [TEMPO] button to call up the Tempo display, and then set the value to the desired 
tempo.

3. Select “Edit” > “Tempo Change” in the Song menu.

4. Select “Execute” and press the [r] button to save the edited data.
NOTICE
Pressing the [r] button overwrites the data of the selected MIDI Song. Be careful not to lose your important data.

Voice Change (changing the Voice of a specific track)
This function lets you change the Voice of a specific track in the selected MIDI Song.

1. Select the desired MIDI Song to edit.

2. Select the desired Voice.

3. Select “Edit” > “Voice Change” in the Song menu.

4. Select the desired track for the Voice change in “Track.”

In the track selection display, the “*” mark indicates the track which contains data. To check the recorded data, play it back 
from “Others” > “Track Listen” in the Song menu (page 11).

5. Select “Execute” and press the [r] button to save the edited data.
NOTICE
Pressing the [r] button overwrites the data of the selected MIDI Song. Be careful not to lose your important data.
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Metronome/Rhythm menu

The Metronome/Rhythm menu lets you set parameters related to metronome and rhythm, such as the time signature of the 
metronome and Rhythm playback-related parameters.

Operation:
Press the [MENU] button several times to select Voice menu, and then use the [u]/[d]/[l]/[r] buttons to select the 
desired parameter and change the settings.

Parameter Description Setting range Default setting

Volume Determines the volume of the metronome or Rhythm. This lets you 
adjust the volume balance between the keyboard performance and 
metronome or Rhythm playback.

0 – 127 82

Bell Determines whether or not the bell sound is played at the first beat of 
the specified time signature.

On, Off Off

Time Sig.
(Time Signature)

Determines the time signature of the metronome. For details, refer to 
“Setting the time signature and tempo to match your score” 
(page 17).

2/2, 3/2, 1/4, 2/4, 
3/4, 4/4, 5/4, 6/4, 
7/4, 3/8, 6/8, 7/8, 
9/8, 12/8

4/4
(For MIDI Songs, 
differs depending 
on the selected 
Song)

BPM Determines whether the note type of the tempo indication on the 
Tempo display is affected by the metronome time signature above or 
not (Crotchet). When “Time Sig.” is selected, the denominator of the 
time signature is shown as the note type of the tempo indication. (The 
dotted quarter note is shown as the note type of the tempo indication 
only when the time signature is set to “6/8,” “9/8,” or “12/8.”)

Time Sig., 
Crotchet

Time Sig.

Intro Determines whether the Intro is played back or not before the Rhythm 
pattern is started.

NOTE
During Song playback, the Intro cannot be played back even if you start the Rhythm with 
this parameter set to “On.”

On, Off On

Ending Determines whether the Ending is played back or not before the 
Rhythm pattern is stopped.

On, Off On

SyncStart When this is set to “On,” you can start Rhythm playback by pressing 
any note on the keyboard.
With this function turned on, pressing the [RHYTHM] button sets 
Synchro start to standby and makes the [RHYTHM] button flash. In 
this status, pressing any key starts Rhythm playback.

On, Off Off

Bass Determines whether the auto bass accompaniment for the Rhythm is 
on or off.

On, Off On
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Setting the time signature and tempo to match your score

Try setting the time signature and tempo to match that of your sheet music score. If you set “Bell” to “On,” the first beat of the 
specified time signature is accented with a bell sound.

1. Select the desired time signature from “Time Sig.” in the Metronome/Rhythm menu.

2. Press the [TEMPO] button to call up the Tempo display.

3. Use the [l]/[r] buttons to set the tempo.
“Note type=tempo value” is shown on the Tempo display. Depending on the time signature you set in step 1, the note type 
and available tempo range differ as follows.

NOTE
• Note type will be fixed to quarter note as long as the “BPM” parameter in the Metronome/Rhythm menu (page 16) is set to “Crotchet” regardless of the time 

signature you set.
• If you select a Song, the time signature and tempo will be changed to those of the selected Song.

Time signature Note type 
(The length of one beat)

Setting range

2/2, 3/2 Half note
3 – 250

1/4, 2/4, 3/4, 4/4, 5/4, 6/4, 7/4 Quarter note
5 – 500

6/8, 9/8, 12/8 Dotted quarter note
4 – 332 (even numbers only)

3/8, 7/8 Eighth note
10 – 998 (even numbers only), 
999

Tempo

Time signature

Note type



CLP-885 CLP-875 CLP-845 CLP-835 CLP-895GP CLP-865GP  Reference Manual 18

Recording menu

The Recording menu lets you set detailed parameters related to MIDI recording. These settings are not applied to Audio recording.

Re-recording a portion of a MIDI Song

You can re-record a part of the specified track in an already recorded MIDI Song. If you want to listen to the data for each track, 
play it back from “Others” > “Track Listen” in the Song menu (page 11).

1. In the Recording menu, set the parameters which determine how recording starts and stops.

• Recorded data for each combination of the “RecStart” and “RecEnd” settings

2. Select the desired MIDI Song to be re-recorded.

Operation:
Press the [MENU] button several times to select Voice menu, and then use the [u]/[d]/[l]/[r] buttons to select the 
desired parameter and change the settings.

Parameter Description Setting range Default setting

RecStart These parameters specify the timing of starting or stopping 
overwriting the data when recording to an existing MIDI Song. For 
details, refer to “Re-recording a portion of a MIDI Song” below.

Normal, KeyOn Normal

RecEnd Replace, 
PunchOut

Replace

RecRhythm Determines whether Rhythm playback is recorded or not in MIDI 
recording. When this is set to “On,” Rhythm parts are recorded to 
tracks 9 to 11.

On, Off On

RecStart Normal The already recorded data will be replaced with the new one as soon as recording starts.

KeyOn The already recorded data will be maintained until you press a key, and actual recording 
starts as soon as you press a key.

RecEnd Replace The data after the point you stop recording will also be erased.

PunchOut The data after the point you stop recording will remain.

Normal/Replace

Normal/PunchOut

KeyOn/Replace

KeyOn/PunchOut

Start overwrite recording Stop recording

Start overwrite recording Stop recording

Start playback of original data
Play the keyboard to start 
overwrite recording Stop recording

Start playback of original data
Play the keyboard to start 
overwrite recording Stop recording

New data No data

New data Original data

Original data No data

Original data

New data

New data Original data
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3. Specify the start point at which you wish to re-record.

Use the [l]/[r] buttons to move the playback position (measure number) to the desired point. Alternately, press the [PLAY/
PAUSE] button to start playback, and then press the [PLAY/PAUSE] button again slightly prior to the desired point.
If necessary, select the settings (Voice and other parameters).

4. Press and hold the [REC] button for a second to call up a list of the recording target Songs, 
and then select again the Song you selected in step 2.

5. Use the [l]/[r] buttons to select a track for re-recording.

6. Play the keyboard or press the [PLAY/PAUSE] button to start recording.

7. Press the [REC] button to stop recording.

8. In the “Confirm” display, select “Save” to save the data.
After saving the data, press the [PLAY/PAUSE] button to listen to the recorded performance.
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System menu

The System menu lets you make the overall settings applied to the entire instrument, format the USB flash drive, back up the 
instrument’s settings, and more.

Operation:
Press the [MENU] button several times to select Voice menu, and then use the [u]/[d]/[l]/[r] buttons to select the 
desired parameter and change the settings.

Parameter Description Setting range Default setting

Bluetooth Bluetooth Switches the Bluetooth function on/off. To connect the 
instrument with a Bluetooth-equipped device such as a 
smartphone, you need to turn this function on.

NOTE
Depending on the country in which you purchased the product, the 
instrument may not have Bluetooth capability.

On, Off On

Pairing For registering (pairing) the Bluetooth-equipped audio 
player. This parameter is shown when “Bluetooth” 
above is set to “On.”
Pressing the [r] button sets the instrument to standby 
for paring. This is the same status as when holding 
down the [ ](Bluetooth) button (on the CLP-885/CLP-
875/CLP-895GP) or [MENU] button (on the CLP-845/
CLP-835/CLP-865GP) for 3 seconds. For details on 
connecting the instrument to a Bluetooth-equipped 
audio player, refer to the Owner’s Manual.

NOTE
Only one smart device can be connected to this instrument at a time 
(although up to 8 smart devices can be paired to this instrument). 
When pairing with the 9th smart device has succeeded, pairing data for 
the device with the oldest connection date will be deleted.

– –

Tuning Master Tune Fine tunes the pitch of the entire instrument. This 
function is useful when you play this instrument along 
with other instruments or CD music.

NOTE
These settings are not applied to the Drum Kit Voices or Audio Song. 
Also, these settings cannot be recorded to a MIDI Song.

(A3=) 414.8 Hz – 
466.8 Hz 
(approx. 0.2 Hz 
steps)

(A3=) 440.0 Hz

Scale Tune Modern acoustic pianos are tuned almost exclusively in 
equal temperament, which divides one octave into 
twelve equal intervals. Likewise, this instrument 
employs equal temperament, but it can be changed to 
play in historical temperaments used in the 16th to 19th 
centuries.
• Equal (Equal Temperament): One octave is divided into 

twelve equal intervals. Currently most popular piano tuning 
scale.

• PureMajor, PureMinor: Based on natural overtones, three 
major chords using these scales produce a beautiful, pure 
sound.

• Pythag. (Pythagorean): This scale was devised by 
Pythagoras, the famous Greek philosopher and is created 
from a series of perfect fifths, which are collapsed into a 
single octave. The 3rd in this tuning is slightly unstable, but 
the 4th and 5th are beautiful and suitable for some leads.

• MeanTone: This scale was created as an improvement on 
the Pythagorean scale, by making the major third interval 
more “in tune.” It was especially popular from the 16th 
century to the 18th century. Handel, among others, used this 
scale.

• Werck. (Werckmeister), Kirnberger: These scales 
combine Mean Tone and Pythagorean in different ways. With 
these scales, modulation changes the impression and feel of 
the Songs. They were often used in the era of Bach and 
Beethoven. They are also often used now to reproduce the 
music of that era on harpsichords.

Equal, 
PureMajor, 
PureMinor, 
Pythag., 
MeanTone, 
Werck., 
Kirnberger

Equal
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Tuning Base Note When Scale Tune is set to something other than 
“Equal,” you need to set the base note. When the base 
note is changed, the pitch of the keyboard is 
transposed, yet maintains the original pitch relationship 
between the notes.

C, C♯, D, E♭, 
E, F, F♯, G, A♭, 
A, B♭, B

C

Keyboard Touch Determines how the sound responds to your playing 
strength. 
• Soft 2: Produces relatively high volume even with light 

playing strength.

• Soft 1: Produces high volume with moderate playing 
strength.

• Medium: Standard Touch Sensitivity.

• Hard 1: Requires moderately strong playing for high 
volume.

• Hard 2: Requires strong playing to produce high volume.

• Fixed: The volume is fixed at the level set in “Fixed Velocity” 
below regardless of your playing strength.

NOTE
The settings here are not recorded to a MIDI Song nor transmitted as 
MIDI messages.

Soft 2, Soft 1, 
Medium, Hard 1, 
Hard 2, Fixed

Medium

Fixed Velocity Determines the velocity at which the sound is played 
when “Touch” above is set to “Fixed.”

NOTE
The settings here are not recorded to a MIDI Song nor transmitted as 
MIDI messages.

1 – 127 64

Duo When this is set to “On,” the keyboard is divided into 
two ranges, allowing you to play duets over the same 
octave range. For details, refer to “Playing by two 
players over the same octave range (Duo)” (page 28).

On, Off Off

–Type Selects the sound balance between the left and right 
speakers while Duo is on.
• Separated: The sound played by the left player is output 

from the left speaker(s), and the sound played by the right 
player is output from the right speaker(s).

• Balanced: The sounds played by the right and left players 
are output through both speakers, with a natural balance of 
sound.

NOTE
When “Separated” is selected, Reverb (page 5), VRM (page 3) and 
Binaural (page 23) are turned off.

Separated, 
Balanced

Separated

Split Point Determines the Split Point (the border between the 
right-hand and left-hand areas) when Split or Duo is 
on. The specified Split Point key is included in the left-
hand area.
You can also set the Split Point by simultaneously 
holding down the [DUAL/SPLIT] button and pressing 
the key you wish to set as the Split Point with the Split 
or Duo function turned on.

A−1 – C7 F♯2 (Split), 
E3 (Duo)

Operation:
Press the [MENU] button several times to select Voice menu, and then use the [u]/[d]/[l]/[r] buttons to select the 
desired parameter and change the settings.

Parameter Description Setting range Default setting
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Pedal Half Pedal Point Here you can specify the point to which you must 
depress the right pedal before the assigned effect 
begins to be applied. This setting is effective only when 
the “Sustain (Cont.)” function (page 7) is assigned to 
the right pedal.

−2 (effective with 
the shallowest
press) – 0 – +4 
(effective with the 
deepest press)

0

Soft Pedal Depth Determines how deeply the Soft pedal effect is applied. 
This parameter is available only for the pedal to which 
“Soft” (page 7) is assigned.

1 – 10 5

Pitch Bend 
Range

Determines the range of the pitch bend that is 
produced via the pedal in semitone steps. This setting 
is available only for the pedal to which “PitchBend Up” 
or “PitchBend Down” (page 7) is assigned.

NOTE
For some Voices, the pitch may not be changed according to the Pitch 
Bend Range value set here.

0 – +12 (pressing 
the pedal will 
raise/lower the 
pitch by 12 
semitones)

2

Play/Pause Assigns the function of the [PLAY/PAUSE] button on 
the control panel to the left pedal or the center pedal. If 
a value other than “Off” is selected here, the 
corresponding pedal's function assigned in the “Voice” 
menu (page 7) is disabled.

Off, Left, Center Off

Sound Brilliance Adjusts the overall brilliance of sound for this 
instrument. This setting is applied commonly to 
keyboard Voices, Song playback and MIDI input from 
the external device.
• Mellow 1 – 3: Soft and mellow tone. The sound becomes 

more mellow and warmer as the number increases.

• Normal: Standard tone.

• Bright 1 – 3: Bright tone. The sound becomes brighter as 
the number increases.

• User: Opens the “User” display, where you can create your 
own custom EQ settings. 
The EQ (Equalizer) is a 
sound processor that 
divides the frequency 
spectrum into multiple 
bands that can be boosted 
or cut as required to tailor 
the overall frequency 
response. This instrument allows you to adjust the gain for 
three frequency bands (Low/Middle/High). 
• Setting range: −6 dB – 0 – +6 dB
• Default setting: 0 dB

Mellow 1 – 3, 
Normal, 
Bright 1 – 3, 
User

Normal

IAC Turns the IAC (Intelligent Acoustic Control) effect on or 
off. IAC is a function which automatically adjusts and 
controls the sound quality according to the overall 
volume of the instrument. IAC is effective only on the 
sound output of the instrument speakers or 
headphones. Even when the volume is low, this lets 
you hear both low sounds and high sounds clearly. 
Especially when using the headphones, the burden on 
the ears is reduced without raising the overall volume 
excessively.

On, Off On

–Depth Determines the depth of the IAC. The higher the value, 
the more clearly the low/high sounds at lower volume 
levels.

−3 – +3 0

Operation:
Press the [MENU] button several times to select Voice menu, and then use the [u]/[d]/[l]/[r] buttons to select the 
desired parameter and change the settings.

Parameter Description Setting range Default setting



System menu

CLP-885 CLP-875 CLP-845 CLP-835 CLP-895GP CLP-865GP  Reference Manual 23

Sound Binaural Turns the Binaural Sampling function on or off. For the 
Voices having VRM effects, when the function is on 
and headphones are connected, the sound from this 
instrument changes to the sound of Binaural Sampling 
or the sound enhanced with the Stereophonic 
Optimizer, allowing you to enjoy more realistic sound.

 Binaural Sampling (only for “CFX Grand” and 
“Bösendorfer” Voice)

Binaural sampling is a method that uses two special 
microphones set at the ear position of a performer and 
records the sound from a piano as it is. Listening to the sound 
with this effect through headphones gives the impression of 
being immersed in the sound, as if it was actually emanating 
from the piano. When one of the corresponding Voices is 
selected, connecting the headphones automatically enables 
binaural sampling sound.

 Stereophonic Optimizer (only for Voices 
having VRM effects, excepting “CFX Grand” 
and “Bösendorfer”)

The Stereophonic Optimizer is an effect which reproduces 
natural sound distance like the sound of binaural sampling 
even though you hear it on headphones. When one of the 
corresponding Voices is selected, connecting the headphones 
automatically enables the Stereophonic Optimizer.

NOTE
• When “Utility” > “Speaker” (page 25) in the System menu is set to 

“On,” this function is disabled even when headphones are connected.
• When Binaural is set to “On” and headphones are connected, these 

effects also affect the sound from the external speaker connected to 
the AUX OUT jacks or the sound for Audio recording, and may result 
in unusual or unnatural sound. If this happens, turn this function off.

On, Off On

Volume Limiter Turns the Volume Limiter function on/off. When set to 
“On,” the maximum volume of the entire sound is 
limited to prevent excessively loud volume and the icon 
( ) appears at the lower right of the Song display 
or the Voice display.

On, Off Off

–Limit 
Point

Determines the maximum volume when the Volume 
Limiter function is turned on. The setting value 
indicates the [VOLUME] slider position (MAX = 100%). 
The volume level will not increase even if you move the 
slider beyond this point.

10% – 100% 50%

MIDI MIDI OUT Determines the MIDI channel over which MIDI 
messages generated via the keyboard performance 
will be transmitted from the USB [TO HOST] terminal. 
When Dual, Split or Duo is on, the MIDI channels are 
assigned as follows.
• Performance via the Right 1 Voice = n (setting value)

• Performance via the Right 2 Voice = n+2

• Performance via the Left Voice = n+1

Ch1 – Ch16, Off 
(not transmitted)

Ch1

Operation:
Press the [MENU] button several times to select Voice menu, and then use the [u]/[d]/[l]/[r] buttons to select the 
desired parameter and change the settings.

Parameter Description Setting range Default setting
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MIDI MIDI IN Determines which part of the instrument will be 
controlled by each channel data of the MIDI messages 
coming from the USB [TO HOST] terminal.
• Song: Song part is controlled.

• Keyboard: The entire keyboard performance is controlled 
regardless of the Dual/Split/Duo setting.

• R1: The keyboard performance via the Right 1 Voice is 
controlled.

• R2: The keyboard performance via the Right 2 Voice is 
controlled.

• L: The keyboard performance via the Left Voice is 
controlled.

• Off: No part is controlled.

Song, Keyboard, 
R1, R2, L, Off

(For all 
channels)
Song

Local Control “Local Control On” is a state in which this instrument 
produces the sound from its tone generator when you 
play the keyboard. In “Local Control Off” state, the 
keyboard and the tone generator are cut off from each 
other. This means that even if you play the keyboard, 
this instrument will produce no sound. Instead, the 
keyboard data can be transmitted via MIDI to a
connected MIDI device or computer, which can 
produce the sound. The “Local Control Off” setting is 
useful when you wish to play only an external sound 
source while playing the keys on this instrument.

On, Off On

Receive Param.
(Parameter)

Determines which types of MIDI messages can be 
received or recognized by this instrument.

MIDI message types:
Note on/off, Control Change, Program Change, Pitch Bend, 
System Exclusive

On, Off (For all 
messages)
On

Transmit Param.
(Parameter)

Determines which types of MIDI messages can be 
transmitted from this instrument.

MIDI message types:
Note on/off, Control Change, Program Change, Pitch Bend, 
System Real Time, System Exclusive

On, Off (For all 
messages)
On

Initial Setup Transmits the current settings on the instrument, such 
as Voice selection, to a connected MIDI device or 
computer. Before you start recording your performance 
to a connected MIDI device or computer, execute this 
operation to record the current panel settings at the 
beginning of your performance data. It causes that the 
same panel settings are called up when the recorded 
performance is played back.
To use this function, select “Execute,” and then press 
the [r] button to transmit the instrument’s settings as 
MIDI messages.

– –

Backup Backup Setting This lets you set whether settings are maintained or not 
when the power is turned off. For details, refer to 
“Selecting parameters to be maintained when power is 
turned off (Backup Setting)” (page 29).

On, Off “Voice” = Off
“Other” = On

Backup This lets you save all User Song data and settings on 
the instrument to a connected USB flash drive as a 
backup file (extension: .bup). For details, refer to 
“Saving the Song data and instrument settings to USB 
flash drive (Backup)” (page 29).

– –

Operation:
Press the [MENU] button several times to select Voice menu, and then use the [u]/[d]/[l]/[r] buttons to select the 
desired parameter and change the settings.

Parameter Description Setting range Default setting
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Backup Restore This lets you load a backup file on a USB flash drive 
(extension: .bup) to the instrument and restore the User 
Songs and settings. For details, refer to “Loading a 
backup file saved on a USB flash drive to the 
instrument (Restore)” (page 30).

– –

Factory Reset This lets you reset the backed up settings to their factory 
default. For details, refer to “Restoring the factory-
programmed settings (Factory Reset)” (page 30).

– –

Utility Speaker Lets you switch the instrument’s speakers on/off.
• Normal: The speakers produce sound only when 

headphones are not connected to the [PHONES] jack.

• On: Speaker sound is always on.

• Off: Speaker sound is off.

NOTE
When this is set to “On,” “Binaural” (page 23) is disabled.

Normal, On, Off Normal

Audio Loopback Determines whether audio input sound from the 
connected computer or smart device is output to a 
computer or a smart device or not along with the 
performance played on the instrument.
For example, if you want to record the audio input 
sound as well as the sound played on the instrument 
by using the connected computer or smart device, set 
this to “On.” If you intend to record only the sound 
played on the instrument by using the computer or 
smart device, set this to “Off.”

NOTE
• In this manual, “audio input sound” refers to audio data that is input to 

the instrument from connected external devices using one of these 
methods: USB Audio Interface function, Bluetooth Audio function, 
[AUX IN] jack or Wi-Fi.

• The sound cannot be output to a device connected by Bluetooth or 
the [AUX IN] jack.

• With Audio recording on this instrument, the audio input sound from 
the external device is recorded when this is set to on, while the sound 
is not recorded when this is set to off. However, when the devices are 
connected via the Bluetooth Audio or [AUX IN] jack, the input sounds 
are always recorded regardless of the Audio Loopback on/off setting.

On, Off On

Auto Power Off Lets you set the amount of time that elapses before the 
power is turned off by the Auto Power Off function. To 
disable the Auto Power Off function, select “Off.”
You can also disable the Auto Power Off function by 
turning the power on while holding down the lowest key 
on the keyboard.

NOTICE
Any data which are not saved will be lost if the power 
automatically turns off. Make sure to save your data before 
this happens.

Off, 5, 10, 15, 30, 
60, 120 
(minutes)

15

Operation:
Press the [MENU] button several times to select Voice menu, and then use the [u]/[d]/[l]/[r] buttons to select the 
desired parameter and change the settings.

Parameter Description Setting range Default setting
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Utility USB Properties Shows the amount of free space and entire memory in 
the USB flash drive connected to the USB [TO 
DEVICE] terminal. 

– –

USB Autoload When this is set to “On,” the Song saved in the root 
directory can be selected (shown on the display) 
automatically as soon as the USB flash drive is 
connected to the USB [TO DEVICE] terminal.

On, Off Off

USB Format This lets you format or initialize the USB flash drive 
connected to the USB [TO DEVICE] terminal. To start 
formatting, select “Execute,” and then press the [r] 
button. After formatting is completed, a message 
appears and the instrument returns to the Utility display 
after a while.

NOTICE
• Executing the Format operation will delete all data saved in 

the USB flash drive. Save important data to a computer or 
another storage device.

• Never turn off the power or disconnect the USB flash drive 
while “Executing” is shown in the display. Doing so may 
corrupt the USB flash drive and the data.

– –

Contrast Adjusts the contrast of the display. −8 – +8 0

Touch Panel 
Sound
(CLP-885/CLP-875/
CLP-895GP)

The control panel conveniently makes a confirmation 
sound when operated; this can be turned on/off here.

On, Off On

Auto Backlight 
Off
(CLP-885/CLP-875/
CLP-895GP)

Lets you set the time that elapses until the control 
panel and the display turn off, or lets you set them to 
remain on indefinitely (the “Off” setting).

Off, 10, 20, 30, 
60 (seconds)

30

Language Determines the type of characters shown on the 
display for the System (general indication other than 
Song name) and Song (Song name) individually.

Character list: 

International, 
Japanese

International

Version Displays the model name and the firmware version of 
this instrument.

– –

Operation:
Press the [MENU] button several times to select Voice menu, and then use the [u]/[d]/[l]/[r] buttons to select the 
desired parameter and change the settings.

Parameter Description Setting range Default setting

Amount of 
entire memory

Amount of free 
space

International

Japanese
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Utility Wireless LAN
* This appears only when 

the USB wireless LAN 
adaptor is connected.

Lets you make Wireless LAN (Wi-Fi) related settings. 
For details, refer to page 31.

– –

Wire-
less 
LAN 
Option
* This 

appears 
only 
when 
the USB 
wireless 
LAN 
adaptor 
is con-
nected.

Wireless 
LAN 
Mode

Determines whether to use an access point 
(Infrastructure Mode) or not (Accesspoint Mode).

Infrastructure 
Mode, 
Accesspoint 
Mode

Infrastructure 
Mode

Initialize Initializes the wireless LAN settings. Select “Execute,” 
and then press the [r] button to initialize the settings.

– –

Detail Displays the Host name, MAC address and the status 
of the network. The Host name can be changed. The 
method of entering characters is the same as 
“Rename” of the Song file (page 12).

(Host name)
Up to 57 
characters (half 
size) including 
alphanumeric 
characters, the 
“_” (underscore) 
and “-” (hyphen).

(Host name)
CLP-***-xxxxxx 
(last 6 figures of 
MAC address)

Operation:
Press the [MENU] button several times to select Voice menu, and then use the [u]/[d]/[l]/[r] buttons to select the 
desired parameter and change the settings.

Parameter Description Setting range Default setting
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Playing by two players over the same octave range (Duo)

This function allows two different players to play the instrument, one on the left and the other on the right. This is convenient for 
practicing duets over the same octave range.

1. Turn the Duo function on from “Keyboard” > “Duo” in the System menu.
On the CLP-885/CLP-875/CLP-895GP, the [DUAL/SPLIT] button turns orange, and on the CLP-845/CLP-835/CLP-865GP, 
the [DUAL/SPLIT] button lights up. The keyboard is divided into two sections, with the E3 key as the Split Point. The Split 
Point key is included in the left player’s area. 

NOTE
The Split Point can be set from “Keyboard” > “Split Point” in the System menu (page 21).

The pedal function changes as follows.
• Right Pedal: Damper pedal for the right player
• Center Pedal: Damper pedal for both the right player and left player
• Left Pedal: Damper pedal for the left player

2. As necessary, press the [EXIT] button to call up the Voice display, and then use the [l]/[r] 
buttons or the [VOICE] button to select the desired Voice.
When Duo is on, the [Duo] indication is shown on the Voice display. Only one (shared) Voice can be selected for both the 
right player and left player.

3. Play the keyboard.
By default, the sound of the left player range is emitted from the left speaker, the sound of the right player range is emitted 
from the right Speaker.

NOTE
•  If you set “Keyboard” > “Duo-Type” in the System menu (page 21) to “Balanced,” the sounds played by both right and left players can be output through both 

speakers, with a natural balance of sound.
• When Duo is turned on, the VRM effect (page 3) is not applied. If you set “Keyboard” > “Duo-Type” in the System menu (page 21) to “Separated,” the Reverb 

(page 5) and Binaural (page 23) effects are also not applied.

4. To turn off Duo, press the [DUAL/SPLIT] button.
NOTE
You can also turn off Duo by pressing any one of the [CFX GRAND], [BOSENDORFER], or [PIANO ROOM] buttons, or by selecting “Off” on the display in step 1 
above.

Split Point E3

Left player

Equivalent to C3 (middle C)Equivalent to C3 (middle C)

Right player
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Selecting parameters to be maintained when power is turned off (Backup 
Setting)

The following data and settings (called backup data) are maintained even when the power is turned off. The parameters contained 
in “Backup Setting” can be set as to whether the settings are maintained or not when the power is turned off.

1. Call up “Backup” > “Backup Setting” in the System menu.

2. Select “On” (to maintain data) or “Off” (not to maintain data) for each of “Voice” and “Other.”

• Parameters contained in “Voice”:
• Voice selection

• All the parameters other than “Transpose” in Voice menu

• Parameters contained in “Other”:
• Song menu: Repeat, Volume (Song- Keyboard), Volume (Audio Song), Quick Play, Play Track

• Metronome/Rhythm menu: Volume, Bell, BPM, Intro, Ending, Bass

• System menu: Tuning, Keyboard (except Duo and Duo Type), Pedal, Sound, MIDI

3. After making settings, press the [EXIT] button to exit from the System menu.

Saving the Song data and instrument settings to USB flash drive (Backup)

The Song data saved to the “User” category and the instrument settings can be saved to a USB flash drive as a backup file 
(extension: .bup). This backup file can be loaded to the instrument via the Restore function (page 30) for future recall. For 
information on specific data contained in the backup file, refer to “Backup data” above.

NOTICE
• If the same backup file (clp-***.bup) is already saved in the USB flash drive, this operation overwrites or replaces this file with the new one.
• It may take 1 – 2 minutes to complete this operation. Never turn off the power while “Executing” is shown. Doing so may result in damage to the 

data.

1. Connect the USB flash drive to the USB [TO DEVICE] terminal.

2. Call up “Backup” > “Backup” in the System menu.

3. Select “Execute” and press the [r] button to start saving data to the USB flash drive.
After the data is saved, a message indicating that the operation is completed appears.

Backup data
• MIDI Songs saved in “User” category
• Following settings in the System menu

- “Bluetooth” > “Bluetooth” (page 20)

- “Keyboard” > “Duo-Type” (page 21)

- “Utility” (page 25)

- Parameters set to “On” in “Backup” > “Backup Setting”



System menu

CLP-885 CLP-875 CLP-845 CLP-835 CLP-895GP CLP-865GP  Reference Manual 30

Loading a backup file saved on a USB flash drive to the instrument (Restore)

By loading the backup file (extension: .bup) saved in the USB flash drive, User Songs and the instrument settings can be restored.

NOTICE
• If any Songs exist in the “User” location of the instrument, executing the restore operation deletes all these Songs. Make sure to move the 

important data to the USB flash drive from “File” > “Move” (page 10) in the Song menu before executing this operation.
• It may take 1 – 2 minutes to complete this operation. Never turn off the power while “Executing” is shown. Doing so may result in damage to the 

data.

1. Connect the USB flash drive containing the backup file to the USB [TO DEVICE] terminal.

2. Call up “Backup” > “Restore” in the System menu.

3. Select “Execute” and press the [r] button to start loading the data to the instrument.
A message indicating that the operation is completed appears, and then the instrument will be restarted.

Restoring the factory-programmed settings (Factory Reset)

The Factory Reset function initializes the settings of the instrument to the factory default. The MIDI Songs saved to the “User” 
category and Bluetooth paring information are not lost even when Factory Reset is executed.

NOTICE
Never turn off the power while “Executing” is shown in the display. Doing so may result in damage to the data.

1. Call up “Backup” > “Factory Reset” from the System menu.

2. Select “Execute” and press the [r] button to start initializing.
A message indicating that the operation is completed appears, and then the instrument will be restarted.

NOTE
All MIDI Songs saved to “User” can be deleted via “File” > “Delete All” in the Song menu. For details, refer to “Managing the Song files” (page 12).

Alternate method for Factory Reset 
You can also restore the factory-programmed settings by the following method.
While holding down the highest key, press the [P] (Standby/On) switch to turn 
on the power.

Highest key

[P] (Standby/On) switch
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Making wireless LAN (Wi-Fi) settings

To connect the instrument with a smart device by wireless LAN (Wi-Fi), the separately sold USB wireless LAN adaptor UD-WL01 
is necessary.

NOTICE
Do not connect this product to a public Wi-Fi and/or Internet service directly. Only connect this product to the Internet through a router with 
strong password protections. Consult your router manufacturer for information on optimum security practices.

NOTE
The USB wireless LAN adaptor (UD-WL01) may not be available depending on your area.

1. Connect the USB wireless LAN adaptor UD-WL01 to the USB [TO DEVICE] terminal on the 
instrument.

2. Select the connection mode from “Utility” > “Wireless LAN Option” > “Wireless LAN Mode” in 
the System menu.

3. Make the necessary settings from “Utility” > “Wireless LAN” in the System menu.
The parameters shown in the display differ between “Infrastructure Mode” and “Accesspoint Mode.” For information on the 
Infrastructure mode, see below, and for the Access point mode, see page 32.

• For the Infrastructure mode:
From “Select Network,” select the desired network in the list. If you want to connect to a network not shown in the list, 
select “Other” at the very end of the list. When you select “Other,” make the SSID, Security and password settings, and 
then select “Connect” to execute.

As necessary, return to the “Wireless LAN” display and make “Detail” settings. After making settings in the “Detail” display, 
make sure to save them by executing “Save.”

Infrastructure Mode This mode uses an access point for data communication between the USB wireless LAN 
adaptor (UD-WL01) and a network. You can use this mode when you connect to another 
network while a smart device is connected to the instrument.
• When the access point supports WPS:

No need to make settings on the instrument. Press the WPS button on the USB wireless 
LAN adaptor for longer than three seconds, and then press the WPS button on your access 
point within two minutes.
NOTE 
For information on the confirmation and changes in the access point settings, refer to the manual of the access point.

• When the access point does not support WPS (or you are unsure):
From the network list shown on the instrument, select the desired one to connect.

Accesspoint Mode This mode allows you to directly connect the USB wireless LAN adaptor and a smart device, 
without the need for using an access point. You can use this mode when there is not any 
access point available for connection to the instrument, or when it is unnecessary to connect 
to another network while a smart device is connected to the instrument.

Parameter Description Setting range Default 
setting

Select 
Network

(Networks) Connects to an access point by selecting 
the network. For a network having a lock 
icon ( ), you need to enter the password. 
The method of entering characters is the 
same as in “Rename” of the Song file 
(page 13).

– –
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• For the Access Point mode:
Make the SSID, Security, password and channel settings to use the instrument as an access point. After making settings in 
this display, be sure to save them by executing “Save.” 

Select 
Network

Other SSID Sets the SSID. The method of entering 
characters is the same as in “Rename” of 
the Song file (page 13).

Up to 32 characters 
(half size), 
alphanumeric 
characters, marks

–

Security Sets the Security. NONE, WEP, 
WPA2-PSK(AES), 
WPA/WPA2 mixed 
PSK

NONE

Password Sets the Password. The method of 
entering characters is the same as in 
“Rename” of the Song file (page 13).

Up to 64 characters 
(half size), 
alphanumeric 
characters, marks

–

Connect Connects the network with the settings 
made in the “Other” display.

– –

Detail DHCP Sets the wireless LAN detailed settings. IP 
Address, Subnet Mask, Gateway, DNS 
Server1, DNS Server2 can be set when 
DHCP is set to Off while cannot be set 
when DHCP set to On. Use the [l]/[r] 
buttons to select each octet in the entry 
display, then enter the value using the [u]/
[d] buttons. To finalize the setting, press 
the [MENU] button.

On/Off On

IP Address 0.0.0.0–
255.255.255.255

0.0.0.0

Subnet Mask 0.0.0.0–
255.255.255.255

0.0.0.0

Gateway 0.0.0.0–
255.255.255.255

0.0.0.0

DNS Server 1, 2 0.0.0.0–
255.255.255.255

0.0.0.0

Save Saves the settings in the “Detail” display. – –

Parameter Description Setting range Default setting

SSID Sets the SSID as an access point. The 
method of entering characters is the same as 
in “Rename” of the Song file (page 13).

Up to 32 characters (half size), 
alphanumeric characters, 
marks

ap-CLP-***-xxxxxx 
(last 6 figures of 
MAC address)

Security Sets the Security as an access point. NONE, WEP, 
WPA2-PSK(AES), 
WPA/WPA2 mixed PSK

NONE

Password Sets the Password as an access point. The 
method of entering characters is the same as 
in “Rename” of the Song file (page 13).

Up to 64 characters (half size), 
alphanumeric characters, 
marks

–

Channel Sets the channel as an access point. Differs depending on the USB 
wireless LAN adaptor models.
• Models for United States and 

Canada: 1–11
• Others: 1–13
When no USB wireless LAN 
adaptor is connected, setting 
range is channels 1–13.

11

Parameter Description Setting range Default 
setting
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DHCP Server Sets the IP address related settings. On, Off On

IP Address 192. 168. 0–255. 1–254. 192.168.0.1

Subnet Mask 255.255.0.0,
255.255.128.0,
255.255.192.0,
255.255.224.0,
255.255.240.0,
255.255.248.0,
255.255.252.0,
255.255.254.0,
255.255.255.0

255.255.255.0

Save Saves the settings you set in the “Wireless 
LAN” display (in the Access point mode).

– –

Parameter Description Setting range Default setting
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